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Murmur
General information

 Murmur is developped with Embarcadero® C++Builder 10.2 ( community edition )
and Epina GmbH SDL Component Suite.

 Murmur is distributed with «Inno Setup» Windows installer.

 Starting from version 9.0.0 the installation process creates a main folder
C:\Murmur and a subfolder named C:\Murmur\Murmur .

 The program uses the subfolder to store all the support files ( .txt and .csv ) and
the ATNF.csv that stores the list and main Pulsars parameters obtained from
ATNF catalogue.

 To fully remove the program from the PC please run the uninstaller and remove
manually the folders.

 The program was scanned with latest Kaspersky anti-virus system ( at the time of
the publication ) before publishing.

 Added, in the download page of the web site, the zipped file checksum information
to guarantee original package integrity.
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Murmur
Revison history 
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Murmur
Installation

The first screen informs that the 
installation process will create the 
main folder and a subfolder.

The next screen asks for 
permission to create a 
shortcut to launch
Murmur. 

The last screen explains how to fully
remove Murmur from the PC.
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Murmur
Initial setup of the program

When «Murmur» is launched for the first time, the program starts in «Pulsar mode»
and a message visualizes the list of all support files needed that will be created

In case that the file ATNF.csv will not be available
the program will stop showing the message
reported on the right. To fix this problem you can
download again Murmur as the installer includes
this file or you can create yourself the file as
described at the end of this visual-manual.
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Murmur
Initial setup of the program

The first thing to define is the type of the antenna .
The program allows to enter «dish antenna» or «other antenna». In the
case of «dish antenna» the program will calculate automatically the gain
based on the dish diameter, while entering « other antenna» you will need
to enter the antenna gain.
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Murmur
Initial setup of the program

By clicking on «dish antenna» the program will load some default
parameter that you can modify to reflect your specific station.
1. Enter Dish diamter in meters.
2. You can modify dish efficiency,

reasonable numbers for amateur
station runs from 45% to 70%. The
higher the better.

3. Enter the frequency at which you
want to make the simulation. Please
note the only two frequency intervals
are available in Pulsar mode : 390Mhz-
500Mhz and 1,000Mhz-1,500Mhz.

4. Enter the line loss before LNA ( the
preamplifier ). This value is usually
very low and 0.1 dB should be ok.

5. Enter the noise figure of your pre-
amplifier.

6. Enter the gain of your preamplifier.
7. Enter the loss of the line after the

preamplifier. Please note that this
value has a very low impact on
overall system performance.

8. Enter the receiver Noise Figure.
Please note that this value has a very
low impact on overall system
performance.

9. Enter T Sky. This value is strictly
depending on frequency in use.
Click button for guidelines.

10.Enter T Spillover. This is the contribution to overall noise of
the ground and of surroundings of the dish. This is usually <
10.

11.Enter Integration time. This parameter defines the total time
of observation in seconds . Usually this is between 1 and 7
hours.

12.Enter integration bandwidth. This is strictly depending on
your receiving system.
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Murmur
Initial setup of the program

By clicking on «other antenna» the program will load some default
parameter that you can modify to reflect your specific station.
1. Enter Antenna gain in dBi
2. Enter the frequency at which you

want to make the simulation.
Please note the only two frequency
intervals are available in Pulsar
mode : 390Mhz-500Mhz and
1,000Mhz-1,500Mhz.

3. Enter line loss before LNA ( the
preamplifier ). This value is usually
very low and 0.1 dB should be ok.

4. Enter the noise figure of your pre-
amplifier.

5. Enter the gain of your preamplifier.
6. Enter the loss of the line after the

preamplifier. Please note that this
value have a very low impact on
overall system performance.

7. Enter the receiver Noise Figure.
Please note that this value has a
very low impact on overall system
performance.

8. Enter T Sky. This value is strictly
depending of frequency in use.
Click button for guidelines.
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9. Enter T Spillover. This is the contribution to overall noise
of the ground and of surroundings of the dish. This is
strictly depending on the type of antenna

10.Enter Integration time. This parameter define the total
time of observation in seconds . Usually this is between
1 and 7 hours.

11.Enter integration bandwidth. This is strictly depending
on your receiving system.
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Murmur
Initial setup of the program

Next the location coordinates must be entered

1. Click either on
1. Set observer location with

sexagesimal notations ( DMS ).
2. Set observer location with QRA

locator.
3. Set observer location with

decimal notation ( D.DDD ).
2. Enter data accordingly to your choice
3. Click confirm
4. Enter Name of location
5. Click Save data

You can add multiple locations or
reset everything by clicking «Reset
Location DB».
Once you decided the location to use
that is listed in the table, activate the
location by clicking .

6. Close the form by clicking «Close and
return to main screen».
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Murmur
Pulsar mode

The initialization is now completed and the following screen should be
displayed. Murmur will show the ATNF Pulsar catalogue version and the
number of Pulsars extracted from ATNF.csv file.
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Murmur
System evaluation mode

«System evaluation mode» allows the analysis of station parameters without
frequency limitations and the visualization of Y-factor noise of the sun and of the
most powerful and interesting cosmic radio sources in the entire frequency range of
NOAA RSTN (Radio Solar Telescope Network) : 245Mhz-15400Mhz.
Pls note that in «System evaluation mode» «bandwidth» replaces «Integration
bandwidth» of «Pulsar mode».

Rev. 18.3.0 11



Murmur
Pulsar mode

Click on «CALCULATE» to show Pulsars that are theoretically detectable.

 If you do not see any PULSAR listed on the box you can try to click on «Above Horizon»
button to see also PSR below horizon.

 It is also possible to modify the S/N by clicking the «Minimum S/N» button. Please bear in
mind that values below 10 make the PSR detection much more difficult !

 If you cannot still see any PSR you can try to increase «Integration time» and «Integration
bandwidth ».
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Murmur
Click on any of the PSR listed to show PSR parameters to visualize the expected S/N
and the real time Azimuth and Elevation based on your location.

Pulsar mode
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Murmur
By clicking on «Track noise sources» the following screen will be displayed
with the real time position ( Azimuth and Elevation ) of the selected PSR
and of the strongest cosmic noise sources.
The screen will also show the strongest Quasar ( 3C273 ), the FRB
20220912A [1], the FRB 20201124A a repeating Fast Radio Burst in a
globular cluster [2] [3] and the FRB Fast Radio Burst-emitting Magnetar SGR
1935+2154 [4] .

Pulsar mode
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[1] ATEL #15691
[2] L. Piro, G. Bruni, E. Troja2, B. O’Connor, F. Panessa, R. Ricci et al.: « The Fast Radio Burst FRB 20201124A in a star forming region: constraints to the progenitor and

multiwavelength counterparts», A&A Volume 656, December 2021
[3] https://astropeiler.de/frb20201124a?msclkid=23a40c3faffa11ec88308a9f01282ad1
[4] Starr, Michelle (16 November 2020). "It's Official: The Fast Radio Burst Coming From Within Our Galaxy Is Repeating". ScienceAlert. Retrieved 17 November 2020.

Please note that SGR 1935+2154 is not reported in 
MURMUR internal Pulsar data base as no S400 and 
S1400 were published.
To find details of this Magnetar visit :
https://www.atnf.csiro.au/people/pulsar/psrcat/



Murmur
The four buttons on the right side allow to predict visibility ( above the horizon ) or full
tracking of the selected PSR for the next 24 hours or for tyhe full month.

Pulsar mode
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Murmur
The «Sorted by S/N» button triggers a procedure that allows the sorting of
the Data Base by any Pulsar parameter.

Pulsar mode
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Murmur
By clicking the «Show all PSR List» Murmur will show the list of all Pulsars
extracted from ATNF.csv file sorted as specified.

Pulsar mode
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Murmur
By clicking the «Select object to track » Murmur will allow to select on
object and the tracking data will be shown in a separate Form.

When this feature is active Murmur will work in conjunction with the program «PstRotator»
from Codrut YO3DMU https://www.qsl.net/yo3dmu/index_Page346.htm allowing direct control
of antenna rotators.

Pulsar mode
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Murmur
By selecting «Culminations» Murmur will calculate the culmination of the
objects shown in the upper side of the screen . Please note that this
calculation may take long time .
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Murmur
By selecting «CALCULATE Noise Y-Factor» Murmur will allow Noise calculations.

 Click on «Download latest flow data» to download latest data from the NOAA ftp site
https://www.swpc.noaa.gov/

When the download from the
observatory site will be
completed the Sun flux and the
Y-factor noise at the required
frequency will be displayed.

Pulsar mode and System evaluation mode

Rev. 18.3.0 20



Murmur
After calculating the Sun noise Y-factor it is possible to enter and save the
measurements taken together with some comment. The program will also allow the
edit of the saved data and the export in .csv format for further analysis.
Please note that Noise Y-factor in «Pulsar mode» is calculated only in two frequency
windows (400 Mhz and 1300 Mhz ) while when in «system evaluation mode » the
calculations are performed for extended frequency range .

Pulsar mode and System evaluation mode
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Murmur
By activating «Show Y-Factor for all noise sources» Murmur calculates the 
expected Noise  Y-factor of the major noise sources.

Pulsar mode and System evaluation mode

 3C273 flux value is calculated by interpolation of data reported in :
M. Türler, S. Paltani, T.J.-L. Courvoisier, et al., « 30 years of multi-wavelenght observations of 3C273 », Astronomy & Astrophysics supplement series, 1999

 Cassiopeia A, Cygnus A, Taurus A, Virgo A  flux values are calculated by interpolation of data reported in :
J.W.M. Baars, P.G. Mezger, H.Wendker « The flux density values of standard sources used for antenna calibration », NRAO,Green Bank, West Virginia, 1964
J.W.M. Baars et.al, Astron. & Astrophys. 61, 99-106, 1977 
W. Herrmann, https://astropeiler.de/sites/default/files/Astropeiler_Story_2.pdf

 Moon flux value is calculated with a dedicated algoritm based on :
a) J. Köppen , « Observation of the Moon» , https://portia.astrophysik.uni-kiel.de/~koeppen/10GHz/moon.html
b) D.Morabito, W.Imbriale, S.Keihm « Observing the moon at microwave frequencies using a large-diameter deep space network antenna », IEEE Transactions on

antennas and propagation , 2008
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 Sagittarius A flux values are calculated by interpolation of data reported in :
S. Roy, P. Rao  « Sgr A∗ at low radio frequencies: Giant Metrewave Radio Telescope observations», Monthly Notices of the Royal Astronomical Society, 349,  L25–L29, 1964
G. C. Bower,S. Markoff et al. « Radio and Millimeter Monitoring of Sgr A*: Spectrum, Variability, and Constraints on the G2 Encounter», The astronomical journal , Feb 2015



Murmur
«PLAN Observation» visualizes all objects in the current internal data base with 
respective Azimuth/Elevation for the 24 hours ( from 00 to 23 ). 
For all the PSR the expected S/N will be listed . On the «Radio Horizon» sub-screen will 
be possible to set local radio horizon defining the minimum elevation in 30° steps

Pulsar mode
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Murmur

By positioning the cursor on any row under the «Detection» column it is possible to 
enter a 9 characters comment.    

Pulsar mode
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Murmur
By selecting «Drift scan planner» on «Plan Observation» screen the future position 
( +10min., +20min., +30min., +40min., +60min. , +120min. ) of  objects above the horizon wil be 
visualized. 
This function helps in positioning the antenna to perform a drift scan.        

Pulsar mode
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Murmur
By selecting «Tracking planner» it would be possible to show tracking data for all 
noise sources entering desidered dates and interval.         

Pulsar mode

Rev. 18.3.0 26



Murmur
«Check for updates» on main screen will check automatically if the installed version of Murmur is
the latest one.        

Pulsar mode
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Murmur
Starting from version 10.0.0 the installer of Murmur will also create in the C:\Murmur\Murmur directory the file 
ATNF.csv with Pulsars data downloaded from ATNF ( Australia Telescope National Facility ) Pulsar catalogue : 
http://www.atnf.csiro.au/research/pulsar/psrcat/.

The ATNF.csv file can also be created ( and edited ) from the user following this procedure :

Download the Pulsar data from ATNF catalogue using following http instruction ( copy and paste ):

http://www.atnf.csiro.au/research/pulsar/psrcat/proc_form.php?version=2.5.1&Name=Name&RaJD=RaJD&DecJD=
DecJD&P0=P0&DM=DM&W50=W50&S400=S400&S1400=S1400&Dist=Dist&Age=Age&startUserDefined=true&c1_v
al=&c2_val=&c3_val=&c4_val=&sort_attr=jname&sort_order=asc&condition=&pulsar_names=&ephemeris=short&
coords_unit=raj%2Fdecj&radius=&coords_1=&coords_2=&style=Short+csv+without+errors&no_value=-
999.99&fsize=3&x_axis=&x_scale=linear&y_axis=&y_scale=linear&state=query&table_bottom.x=87&table_bottom
.y=35

Be sure to put the required version  !

Creating ATNF.csv file

Name:        Pulsar name.  The B name if exists, otherwise the J name.
RAJD:         Right ascension (J2000) (degrees)
DecJD:       Declination (J2000) (degrees)
P0:              Barycentric period of the pulsar (s)
DM:            Dispersion measure (cm-3 pc)
W50:         Width of pulse at 50% of peak (ms). 
S400:         Mean flux density at 400 MHz (mJy)
S1400:       Mean flux density at 1400 MHz (mJy)   
Dist:           Best estimate of the pulsar distance using the YMW16 DM-based distance  

as default (kpc)
Age:           Spin down age (yr) 

Note : The value-999.999 indicates that the data is not available
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Murmur
Select all data and save : ->File -> Save as ->ATNF.txt

Creating ATNF.csv file

ATNF.csv must be as per above screenshot
Note : fields must be semicolon delimited

Open Microsoft Excel ( or equivalent ) and import data : 
-> Data -> From text -> «ATNF.txt»-> Import ->Delimited->Start import at row-> 6 

(Please be sure that row 6 cointains «Catalogue version»)
-> Next->Tab, Semicolon->Next->General->Finish->OK

Save file : ->File->Save as -> «ATNF.csv»  (with format csv (ms-dos ) )  -> yes

Rev. 18.3.0 29



Murmur
General

Clicking on buttons the program will show details and references
on the specific parameter.

By clicking on «History» button you will be able to see all the
program modifications from the first release.

The program works with «.» decimal sparators. In case of troubles
with different OS settings please let me know.

Please report any problem / suggestion / correction to :
mario.natali@gmail.com

«Murmur» can be downloaded from web site :
http://i0naa.altervista.org
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Murmur
Disclaimer

If you download and use this program means that you agree to 
following disclaimer :

THIS SOFTWARE IS PROVIDED ''AS IS'' AND ANY EXPRESS OR 
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE 
AUTHOR AND CONTRIBUTORS BE LIABLE FOR ANY DIRECT, 
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF 
USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER 
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE 
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE.
YOUR USE OF THIS SOFTWARE IMPLIES YOU HAVE ACCEPTED 
THAT IT IS FIT FOR PURPOSE.
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